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Introduction

Thank you for purchasing the LUSCINIA Acrylic Sheet Modern Vinyl Turntable. This
instruction manual contains important information about its safety, usage and
disposal. Use the product as described and keep this manual for future reference. If
you sell this turntable or pass it on, please also give this manual to the new owner.

Safety Instructions

Read and understand this entire manual before using this product. Keep these
instructions for future reference.

1. Do not use the turntable near water.

2. Only connect the turntable to a power outlet type as indicated on the marking
label or in the "Specifications" section of this instruction manual.

3.The turntable has a polarized plug (one pin is wider than the other). To reduce the
risk of electric shock, this plug is intended to fit into a polarized outlet in only one
orientation. If the plug does not fit fully into the outlet, reverse the plug. If it still
does not fit, contact a qualified electrician. Do not attempt to modify the plug in
any way.

4. Protect the power cord from being walked on-or pinched, particularly at the power
plug, at the point of connection between the plug and outlet and at the point of
connection between the power cable and speaker.

5. Do not overload wall outlets or extension cords as this will be a fire hazard and may
cause electric shock.

6. Never push objects of any kind into the turntable through openings as they may
touch dangerous voltage points or short out parts that could result in a fire or
electric shock. Never spill liquid of any kind on the product.

7. Do not attempt to service the turntable yourself as opening or removing body

panels may expose you to dangerous voltage or other hazards. Refer all servicing
to qualified service personnel.

8. Changes or modifications to the turntable not expressly approved by the party
responsible for compliance could void the user's authority to operate the product.

9. Do not use attachments not recommended by the manufacturer as they may cause
hazards.

10. Only place on aflat, sturdy table or use with the cart, stand, tripod or
bracket as specified by the manufacturer or sold with the turntable.
When a cart is used, use caution when moving the cart/turntable
combination to avoid injury-from tip-over.




11. Slots and openings in the cabinet are provided for ventilation and to ensure
reliable operation of the product and to protect it from overheating. Do not block
or cover these openings.

12. Unplug the product during lightning storms.or when unused for long periods of
time.

COMPLIANCE WITH FCC REGULATIONS

This device complies with Part 15 of FCC rules. Operation is subject to the following
two conditions:

(1) This device may not cause harmful interference, and

(2) This device must accept any interference received, including interference that may
cause undesired operation.

This equipment has been tested and found to comply with the limits for a Class
B digital device, pursuant to Part 15 of the FCC rules. These limits are designed to
provide reasonable protection against harmful interference in a residential installation.

This equipment generates, uses and can radiate radio frequency energy and, if not
installed and used in accordance with the instructions, may cause harmful interference
to radio communications. However, there is no guarantee that interference will not
occur in a particular installation.

If this equipment does cause harmful interference to radio or television reception,
which can be determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or more of the following
measures:

« Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.

- Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected.

- Consult the dealer or an experienced radio/TV technician for help.

WARNING: Changes or modifications to this unit not expressly approved by the party
responsible for compliance could void the user's authority to operate the equipment.

Product Description

LUSCINIA

1. Motor Pulley

2. Drive Belt

3. Turntable Spindle

4. Turntable Sub-platter
5.Turntable Platter

6. Lid Hinge

7. Counterweight
8.Tonearm Lift Lever

9.Tonearm Rest & Clip

10. Tonearm

11. Function Knob
12.33/45 RPM Selector

13. Play/Stop Switch

14. Stylus Cartridge

15. Ground Connector

16. Phono & Line Out Jacks

17. Phono & Line Out Switch
18. USB Port for PC Link

19. Bluetooth Indicator

20. Power Cord Jack

21, Pitch Adjustment Screws
22. Power Switch



Included Items

Before installing the turntable, check the package contents to ensure all parts below
are included and free of visible damage. Please retain the original packaging materials
for exchange or return purposes.

1. Turntable Unit 9. Power Adapter

2. Turntable Lid 10. USB Cable for PC Link

3. Slip Mat 11. Cartridge Alignment Protractor
4. Turntable Platter 12. Instruction Manual

5. Sub-platter 13. Ground Wire

6. Tonearm Counterweight 14. RCA Audio Cable

7.45 RPM Adapter 15. Slotted Screwdriver

8. Drive Belt

Installing the Turntable
- Mount the turntable on a level surface.

- To avoid the effects of vibrations and acoustic pressure, do not mount the turntable
next to items such as speakers.

- The turntable may pick up radio static if placed next to a radio. Therefore, try to keep
the turntable away from transmission devices such as radios.

- If the turntable is near equipment (cell phone, etc.) that emits strong radio waves,
noise may occur.

Turntable Platter and Belt Setup

1. Remove the protective packaging and ensure the turntable is placed on a sturdy
and level surface.

2. Remove the sub-platter and the pearl cotton, and then tear off the protective film
on the surface of the acrylic sheet.

3. Insert the sub-platter spindle into the hole in the middle of the turntable.
4. Loop the drive belt around the sub-platter and motor pulley (brass-colored).

5. Rotate the Sub-platter.

1)Using your hands, slowly rotate the sub-platter ten
times or more in a clockwise direction.

2)This step is for resetting the auto mechanism,
getting rid of any twists in the belt and making

sure the belt rides smoothly along the drive rim on

the underside of the platter,



6. Carefully place the main platter onto the sub-platter.

7. Place the slip mat on top of the platter. Make sure the LUSCINIA logo on the mat is
facing up.

2. Carefully push and pull the Counterweight and stop when it reaches the tick mark
of recommended tracking force.

Tonearm Counterweight

=1 P

Note: Each mark on the dial represents 0.5g. The recommended tracking force for
the factory-installed cartridge is 2.5g+0.5g.
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3.If the counterweight loosens or moves during the usage, please gently turn the
screw to make it tight again.

Installing the Lid

Insert the hinge pockets of the lid onto the hinges of
the turntable.

Connection to External Speakers with RCA Audio Cable

If you wish to use your own amplifier or speakers, please follow the instructions below:

RCA wired connection

A 6

Active Speakers

or

Amplifier




1. Setting Phono & Line Out Switch With PHONO Without PHONO
This product has a built-in phono equalizer function. You can use the product even
if you do not have a phono amplifier or connectable equipment with a built-in PHONO=  -LINE PHONO= LINE
phono amplifier. 1T 1T

Use the Phono & Line Out Switch to set the output, as shown below.

Connectable device Position of the Phono & |Where to connect RCA A
being used Line Out Switc audio cable
Device with phono input |PHONO Phono input jack and

ground (earth) terminal of|
connectable equipment
Device without phono  [LINE AUX or line input jack of
input

connectable equipment

&
NOTE: The RCA Jacks are not designed to be connected directly to the

passive/unpowered speakers on LINE mode. If connected to the passive o Elold 9.8
speakers, there will be no sound. e f ‘i‘

i
B
©
O
o

i 4 O To outlet
2. Connecting the device

-y (i
Align the settings for the Phono & Line Out Switch and connect the RCA audio

cable to an input jack that is compatible with the connectable equipment you are Con?f\?:]akl)'lf?eﬁl:icp)ment
. . X ifier, etc.
using (amplifier, active speakers, etc). P

«The RCA audio cable's red jack is for the right (R) channel, and the white jack is
for the left (L) channel.

To outlet
- [
[N
With PHONO Without PHONO
PHONO AUX
L R L R



Main Power Connection

1. Insert the DC plug of the AC adapter cord into the DC INPUT Jack at the back of the
turntable.

2. Plug the AC adapter into a normal power outlet.

NOTE: Do not plug the AC power adapter into a power outlet before all turntable
assembly is completed. Before turning on turntable power, recheck all connections to
make sure they are correct and secure. Always turn off the turntable before connecting
or disconnecting from power.

Playing a Record

1. Before playing a record
1.1 Pull the protector straight forward to remove it. é

NOTE: Applying a downward force may CAREFUL!
cause the stylus to come off the body. Only
low volume will be output if the stylus has
come off, or is about to come off, so refer to WA
“Replacing the stylus”to reattach the stylus Protector@

correctly.

If playing a 45 RPM record with a large center hole, attach the 45 RPM adapter.

2. Turntable Operation

2.1 Connect the included power adapter to the turntable and turn the Power Switch
to the "ON’ position.

2.2 Remove the stylus protector from the stylus.

10

2.3 Place the record on the slip mat. If using 45RPM records, put the 45RPM adapter
on the center spindle before placing the record on the platter.

2.4 Rotate the Function Knob to LP mode. G
2.5 Rotate the 33/45 RPM Selector according to the type of record. ,
2.6 Turn on the Play/Stop Switch, the platter will start spinning. 45RPM Adapter

2.7 Unlock the tonearm clip and set the tonearm lift lever to the up position.
2.8 Position the tonearm over the desired location (groove) on the record.

2.9 Set the tonearm lift lever to the down position and carefully lower the tonearm
on the record.

2.10 When you are finished playing the record, set the tonearm lift lever to the up
position, raise the tonearm and return it to rest on the arm clip. Turn off the Play/
Stop Switch.

2.11 The working principle of the turntable is that the cartridge obtains the analog
music signal on the record, which could be affected by the high magnetics, high
frequency, and high voltage indoors or outdoors. If there is high magnetics, high
frequency, and high voltage indoors or outdoors, please ground the turntable
to a grounded metal object with the included ground wire to enhance the anti-
interference of the turntable and obtain a premium and clear sound quality.

NOTE:

1. The platter will stop spinning automatically if there is no sound output in 3
minutes. To resume operation, position the tonearm over the desired groove on
the record and rotate the Play/Stop switch.

2.1f the felt mat gets dirty, it can easily scratch the record, so remove the felt mat
periodically and wipe off any dust.

3.To prevent the record from scratches and warping, remove it after use.
4. Do not use a disk stabilizer.

11




Wireless Operation

This appliance is equipped with Bluetooth. TX mode allows this turntable to wirelessly
transmit audio to your Bluetooth speaker or headphone.

1. Power on your Bluetooth speaker or headphone and ensure it's in pairing mode.
Please turn off other devices' Bluetooth function except for the Bluetooth speaker or
headphones you want to connect(including the Bluetooth on your phone).

2. Power on the turntable. Rotate the Function Knob to TX. The Bluetooth indicator light
on the back will turn on.

3. When pairing, the blue light will flash and will become solid when paired successfully.

4. This turntable will connect to the nearest Bluetooth speaker. If you need to connect
again, rotate the Function Knob to LP, and then rotate it to TX to start over.

NOTE:

1.The initial connection may take longer, usually between 30 to 80 seconds. After a
successful connection, the subsequent connection time will be shortened to 10
seconds. Please be patient and wait.

2. The Play/Stop button can only control the operation of the platter. To control
music streaming through Bluetooth, please use the control panel of your
media device.

3. Bluetooth version: 5.0
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Recording the Vinyl to Your Computer

Please follow the below steps to set up Audacity to record from the USB audio device.
For more details, please refer to the BRIEF INTRODUCTION OF AUDACITY at https://
manual.audacityteam.org/man/recording_with_usb_turntables.html

1. Download the Audacity software and complete installation
1.1 Ensure your Audacity software is up to date. You can download the current
version from http://www.audacityteam.org/download/

1.2 Follow the instructions to complete installation.
2. Set up Audacity to record from the USB audio device.
2.1 Connect the USB device

Use the supplied USB cable to connect your turntable and your computer. No
extra driver is required.

2.2 System settings needed for Windows and Mac

Windows:

1. By the system clock, right-click over the Speaker icon select Sounds then
the Recording tab, and then click on the USB device in the list and click
Properties. Click the Advanced tab set your required bit rate and sample rate
from the Default Format dropdown (normally "2 channel 16-bit 44100 Hz").

2.0n the Advanced tab, in the "Default Format" section, make sure the
dropdown menu is set to "2 channel 16-bit 44100 Hz"

For a more detailed walk-through of the above steps for Windows (or if that does

not work for your version of Windows), see Windows: accessing the Windows

Sound controls.

Mac:

1. From Apple Menu > System Preferences select "Sound" and click on the /nput
tab

2. Select "USB Audio CODEC" or similar as the input device and verify the
Recording Meter shows input.

3. If the recording meter in the Sound preferences panel does not show input:
1. From the Finder, select Go > Utilities and open Audio MIDI Setup.

2. If the Audio Devices window is not visible, select Window > Show Audio
Devices.

3. Select your USB input device in the listin the left pane of the Audio Devices
window.

4. Set the Format t0 "44100.0 Hz" and "2ch-16bit"

For a more detailed walk-through of the above steps for Mac, see Mac and USB
input devices on the Audacity Wiki.
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2.3 Launch Audacity.

If Audacity is already running when you connected the cable, choose Transport
>Rescan Audio Devices or restart Audacity.

2.4 Project Rate

Set the Audacity Project Rate in Selection Toolbar at the bottom left of the
Audacity screen to 44100 Hz:

Project Rate (Hz): | Snap-To Audio Position Start and End of Selection ~
of  ~||[00h00m00.000s~ |[00R00mO00.000s~ [00h00mM00.000s~
2.5 Devices

Use Device Toolbar to set the recording and playback devices and to set the
recording channels to "2 (Stereo) Recording Channels', as in the below example on
Windows 10:

MME v Analog Connector (UA-1EX) 2 (Stereo) Recorc ~ W) | Speakers
L g p

- The Recording Device is set to the USB device (in this case the device name, but
often called or including the phrase "USB Audio CODEC").

+ Recording Channels is set to stereo.

« The Playback Device is set to the named speakers of the built-in computer sound
device.

- These settings can also be changed in Devices Preferences.

Windows calls most USB external devices "microphones”. Some higher-end USB

recording interfaces may appear as their explicit manufacturer's name.

3. Software Playthrough

Use Transport > Transport Options > Software Playthrough (on/off) and click
"Software Playthrough' to turn it "on" (the checkmark is shown when it is "on").
This setting can also be enabled or disabled in Recording Preferences. Software
Playthrough lets you hear the turntable through the computer speakers when
recording. It also lets you hear the turntable without recording if you turn on
monitoring (see the next section below).

4. Monitoring
Enable monitoring to set the recording level

- Turn monitoring on by clicking once on the microphone icon in the Recording
Meter.

\_, — ﬁﬁ&&mz!m 3633 -30 27 24 21 18 -15-12 -9 & %'3 0 %
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- In Mixer Toolbar, turn up the left-hand playback volume slider (by the speaker icon).
- + - +
\ o o ~a
- The right-hand recording volume slider (by the microphone icon) can often be used
to vary the loudness of the recording, but it may not function with all turntables.

If it does not, try adjusting the output level on the turntable (often, there is a gain
control under the chassis).

Alternatively, you may be able to adjust the input level on Windows and Linux only,
usually by looking for the speaker icon by the system clock. On Windows, right-
click over the speaker icon > "Recording Devices" Then right-click over USB
Audio Codec, choose "Properties" and click the Levels tab.

« Try to aim for a maximum peak of around -6 dB, which corresponds to
around 0.5 on the waveform. You can always boost the level later with Effect
> Amplify... or Effect > Normalize... after you have completed editing.

5. Recording

Then, ignoring any instructions in the manufacturer's guide to select "stereo mix,
simply press the Record button @ in Transport Toolbar to start recording from the
turntable.

6. Recording, editing and exporting

Once your USB turntable is set up and working properly, go to the Basic Recording,
Editing and Exporting section of Audacity’s Tutorial - Copying tapes, LPs or
MiniDiscs to CD for instructions on how to:

- make and edit your recording

- export it to an audio file

- import it to iTunes or Windows Media Player
« burnittoCD

Audacity’s reference links:

- Basic Recording, Editing and Exporting : https//manual.audacityteam.org/man/
basic_recording_editing_and_exporting.html

- Tutorial - Copying tapes, LPs or MiniDiscs to CD : https//manual.audacityteam.
org/man/tutorial_copying_tapes_Ips_or_minidiscs_to_cd.html

Please notice that the turntable's USB-PC recording function is only
available in LP mode and does not work in Bluetooth mode.
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Turntable Body 1. Mount the new replacement stylus to the cartridge.

When the turntable body is dirty or dusty, first disconnect the AC adapter and then
wipe off the dirt and dust with a soft, dry cloth.

- Do not use benzenes, thinners, etc.

« When storing the product for a long time, disconnect the AC adapter from the
outlet and wrap the product in plastic; do not allow it to become damp; the drive
Tips for Stylus Cleaning

belt should be removed to prevent unequal stretching.

or St .0 X B engece in body
If dirt and grime are stuck to the stylus tip, clean it Engage in body first

with a commercially sold brush.

:

« We recommend using a stylus cleaner (not

ﬁ

included) if the stylus tip is considerably dirty. — 2. Lift the stylus up until you hear a click.

Clean the stylus tip by moving the brush from the
rear to the front of the stylus tip.

Replacing the Stylus

It's suggested to replace the stylus after 400 hours of use.

Removing the Stylus

- In addition to the deterioration of sound quality, records may also be damaged as
the cartridge’s stylus tip wears down.

« Be sure to disconnect the product’s AC adapter from the outlet.
« When replacing the stylus, hold the headshell and the cartridge body tightly.
Rotate the front of the stylus in a forward and down motion.
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Replacing the Belt

« The beltis a consumable part. Replace the belt if the speed of playback slows down
orirregular rotation occurs. As a rule of thumb, we suggest replacing the belt once
a year.

- Before replacing the belt, be sure to disconnect the product’s AC adapter from the
outlet.

1. Remove the slip mat.

1 ¥

(=)
2. Remove the main platter and then remove the old belt.

4. Using your hands, slowly rotate the sub-platter ten times or more in a

10x

clockwise direction.

Cartridge Replacement

1. Before replacement, put the stylus protector back on the stylus to prevent damage
to the stylus during the replacement process.

2. Carefully remove the wire leads from the original cartridge.

3. Loosen the two screws on the headshell that are securing the cartridge and then
remove the original cartridge.

4. Mount the new cartridge to the headshell and tighten it lightly. Do not completely
tighten the screws at this moment.

5. Connect the wire leads to the new cartridge’s terminals. The wire lead color codes
are as below:

Wire Channel

Red Left channel positive (L+)
Green Left channel negative (L-)
Copper Right channel positive (R+)
Blue Right channel negative (R-)
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6. Adjust the cartridge’s position to make sure it is precisely aligned on the headshell
so that the stylus will be appropriately tracking within the grooves.

To achieve this, place the included paper cartridge alignment protractor over
the turntable spindle, carefully lift the tone arm, and place the tip of the stylus on
the points marked 126.5mm and 237.8mm respectively. Fine tune the cartridge’s
position on the headshell until the cartridge is perfectly in parallel with the
reference lines at both points.

7. Tighten the screws completely once perfect alignment is achieved.

NOTE: If you are unfamiliar or uncomfortable with completing this procedure, we
recommend consulting with a professional to perform the installation.

When the Turntable is Moved

Using the product's original packing materials, wrap the turntable in the reverse order

from when you unwrapped it. If you do not have the packaging materials, take the

following measures:
- After disconnecting the AC adapter from the outlet, remove the felt mat and platter,

and then wrap them so that they do not get damaged.

- Attach the protector to the cartridge.

« Use a string or something similar to tie the tonearm to the rest so that it does not
become dislodged.

+ Wrap the turntable body with paper or a soft cloth so that it does not get damaged.

Troubleshooting

Problem

Solution

The platter does
not spin.

- Is the AC adapter connected to the outlet?

-Connect the AC adapter to the outlet.

- Has the belt slipped from the platter?

-Correctly place the belt on the platter.

« Is the belt placed on the motor pulley?

-Check that the belt is placed on the motor pulley (brass-colored)
correctly.

- Has the belt been damaged?

-Replace it with a new belt.

The platter spins,
but there is no
sound or the
volume is not

- Are the function settings and input for connected equipment

(amplifier, etc.) selected correctly?

-Check whether the settings for the connected equipment are
correct.

« Is the stylus damaged?

-Check the stylus and replace it, if necessary.

« Is the stylus placed correctly on the body of the cartridge?

-Check the cartridge and adjust it, if necessary.

- Are the setting positions for the Phono & Line Out Switch

correct?
-If you are connection to the speaker with RCA audio cable,

loud enough. check that the Phono & Line Out Switch are correct, noting the
following common problems and their causes:
-If there is no sound, or if the volume is not loud enough, the
product is set to the "PHONO" position and connected to the
amplifier's AUX/LINE input.
-If the volume is too loud or is distorted, the product is set to the
“LINE" position, and the connectable equipment is connected to
the PHONO input.

- Is the record warped?
) -Check the record.
The stylus skips.

« Isthe record scratched?

-Check the record.

There is howling.

- Is the product picking up excessive vibrations from the floor,

surfaces of the walls, or nearby speakers?

-Decrease the vibrations or mount the product on a surface that
is not subject to the effects of vibrations.

« Is the product mounted on an unstable surface?

-Check whether the surface on which the product is mounted is
suitable.

There is noise
when the record

is playing.

- Is there dust on the cartridge’s stylus tip?

-If dust is stuck to the stylus tip, clean it with a commercially sold
brush.

The sound when
the record is
playing is either
too fast or too
slow.

- Are the speed settings for this product correct?

-Please select the correct speed for the type of record being
played.

- ‘Turn the pitch adjustment screws carefully to adjust the speed.
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Playback speed |- Is the belt stretched out? How to adjust the speed?

slows down or -Replace with a new belt. - Please use the screws to adjust speed after excluding other causes that may affect
there is irregular the speed.

rotation. - Start the turntable. When the platter is spinning, use a slotted/flathead screwdriver to
Needle is not - The screw on the tonearm rest may have loosened during turn the pitch adjustment screws carefully to adjust the speed.

touching the transport. Gently turn this screw clockwise to move the needle

stylus closer to the record.
record. Y ‘\_ + /’
Needle is + Gently turn the tonearm rest screw anticlockwise to move the
scratching the needle stylus away from the turntable. 3 3 45
record's surface.

NOTE: Factory screw tightness is based on the thickness of the included slip mat.
If a thinner or thicker 3rd-party slip mat is used, gently adjust the screw as needed L J
following the steps in the last two trouble shooting topics. PITCH ADJUSTM ENT
Counterclockwise: Slow down Counterclockwise: Slow down

Does the arm automatically go onto the record to play and vise versa? Clockwise: Speed up Clockwise: Speed up
- The turntable is not automatic, so you should manually put the tonearm onto the

record or put it back. However, the platter will stop spinning 3 minutes after the

record ends.

Can't connect to the Bluetooth speakers, any suggestions?

1.When connecting Bluetooth for the first time, please reset the Bluetooth speaker
or Bluetooth headphones that you want to connect and clear all Bluetooth pairing
records.

2. Please turn off other devices' Bluetooth function except for the Bluetooth speaker
or Bluetooth headphones you want to connect(including the Bluetooth on your
phone).

3. Please rotate the Function Knob to TX.

4. The initial connection may take longer, usually between 30 to 80 seconds. After
a successful connection, the subsequent connection time will be shortened to
10 seconds. But due to differences in Bluetooth protocols among various brands
and models of speakers or headphones, the connection time may sometimes be
extended. Please be patient and wait.

5. Due to differences in Bluetooth protocols among various brands and models of
speakers or headphones, there may be cases where the Bluetooth connection is
unsuccessful.
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Turntable

Model 1-AD07USQ5, LP11

Power Supply AC Input 100-240V 50/60Hz, DC Output 9V 1000mA
Power Consumption oW

Turntable Speed 331/3,45 RPM

Signal to Noise >35dB

Tracking Force Range 0-3.5g

Wow and Flutter <0.2%

Dimensions (L x W x H) 16.5"* 13.5"*4.9"(42 * 34.4* 12.4cm)
Weight 131b(6.3kg)

Stylus

Model Audio-Technica AT3600L
Frequency Response 20Hz - 20kHz

Channel Balance <2.5dB

Channel Separation >18dB

Output Voltage 2.5mV

Recommended Load Resistance [47kQ)

Amplifier Connection

MM (Moving Magnet) - input

Recommended Tracking Force

2.5+0.5g

Weight

0.180z (5.19)

Note: Design and specifications are subject to change without notice.

@ This product’s packaging is made from environmentally friendly material
%9 and can be disposed of at your local recycling plant.
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Customer Service/Kundenservice

Service Clients/Atencion al cliente/Assistenza Clienti

Phone: +1 909-391-3888 (Mon-Fri 9:00am - 5:00pm PST)
UNITED STATES .
Email: ushelp@1byonebros.com
CANADA Email: cahelp@1byonebros.com
Phone: +44 158 241 2681 (Mon-Fri 9:00am - 6:00pm UTC)
UNITED KINGDOM ‘
Email: ukhelp@1byonebros.com
GERMANY/FRANCE _
Email: euhelp@1byonebros.com
ITALY/SPAIN
BRAND OWNER

Tbyone Products Inc.

1230 E Belmont Street, Ontario, CA, USA 91761
Customer Service: +1 909-391-3888

www.1byonebros.com
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